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MpdéAoyoc

Ayarnnroi xprioteg Tou S7-200,
Me Tt ouvexn pdodo TG TeXVoAoyiag oTo XwPo Tou AUTOUATIOMOU Kal KaBwg Ol arnatTrioelg
yla pelwon Tou KdoToug otnv apaywyn eivat 6Ao kal peyallTtepeg, N XPrion Twv EAeykTwv
Mpoypappatiiduevng Aoyiknig (PLC) au&dvetal ouvexws.
Edikd to PLC S7-200 xpnotuoroleltal ae Ao Kal TEPLO0OTEPESG EPAPOYEG YiaTi ouvdUdlel
MEYAAN oxU, XxaunAn Tir kat anAn Aettoupyia.
lMa va kdvete Ta npwTa Prjuata otov KOoUo Tou S7-200 e Tov Tio arnAd Tpdro,
dnuoupyroape 1o Eloaywyiké Makéto S7-200.
To «Eyxelpidlo Ekudbnong oe 1 ‘Qpa» Ba oag Bonbrioel va ndbete TIg BACIKEG AelToupyieg
Tou Xpelddovtal yia va Eekivrioete va douleleTe e To S7-200 010 oUVTOUdTEPO duvaTd
XPOVO.
2ag euxOuaoTe KA apxn Kat KaAr ertuxia.
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EykardaoTaon 1

1.1 JuvapHoAdynon Twv UAIKWV

ZuvapuoAdynon Twv UAIKWV
1. Zmpi&te ™ pdya oe éva mAaiolo otpLENG.

M\aiolo otpIENg \

2. Bdwote Tov eEopolwTr| otV KAgpooelpd Tou S7-200. Bpiloketal oto kdtw pépog tou PLC.

S7-200
CPU 222

E&opowmq el06dwv

3. Mpooappdote to PLC ot pdya.
4. TMpooapudote To PHovTENo Kivnmpa otn pdya, dirmka oto PLC.



Eykatdotaon

1.2 H dopn evég S7-200 (CPU 222)
KAEpeg
eEOdwV Tpogodooia
-

AloKAITMG emAoyng
katdotaong Aetroupyiag
STOP, TERM, RUN

OUpa olvdeong
MovABwv EMEKTAONG

Avaloyiko
TIOTEVOLOHETPO
L
OUpa mpoypPaATIopoU KA\épeg TpoPodOoTIKS.
RS 485 €l06dwv Mapé€xel 24 V DC / 180 mA



Eykatdotaon

1.3 KaAwdiwon

Aldypappa KaAwdiwong Twv UNIKWV

Juvdéate Ta KaAwdla énwg paivetal oto mapandvw oxrud. To YKPL KOAWSIO CUVIEETAL OTIq
kAéueg L+ kat 1L kat oto povtéAo.

:_ ______________ ,_ - -; MPOZOXH: Kivduvog
Movté\o 1 TPAUUATIONOU Kat
! Isi ’ | KATAOTPOPIG UNK®V.
lo [eiwon Kvnmea |
: (HrtAe) |
1 |
| 1
1 |
| 1
1 |
1 I
1 |
1 |
1 ANay” ! Tpogpodooia:
| Onfoff  kateGBuvong | 85-264VAC/47 to 63 Hz
; (KOKKIvO) (Maupo) " Na ouvdéete mdvta Tn
| 1 yeiwon PE !
YKpL : L1
| N
o PE
- I. S R B
(0] O OO0 O 00O O l 00
1L Q0.0 01 0.2 03 PE N L1

S7-200 (CPU 222)
6ES7 212-1BB23-0XBO

x____________

100 01 02 03 2M 04 05
Tpocpoéo'rl

79928000 T‘f‘f‘f::::::

r_____________




Eykatdotaon

ZXNUaTiKG 31Aypappa TwV UAIKWV

Tpopodoaoia:
85-264V AC /47 to 63 Hz
Na ouvdéete ndvra
yelwon PE !

PE N LI
/ / / EMagég Twv E0WTEPIKWV

Hikpopehal Twv eE6dwV

1L Q0.0 01 0.2 0.3

S7-200 CPU 222

|
|
|
|
|
|
|
|
|
|
|
|
: 6ES7 212-1BB23-0XB0
|
|
|
|
|
|
I
|
|
|
|
|

m

{oodo1 24 V (onfjuata ewdédou 0 - 24 V DC)

M 10.0 03 2M 00 05 M L+ ,
TpopodoTIKO

5 ?_:?: f?__|__?__ﬁ>__$ 3'?_“9:9:::::::::I

AN A=

L e e e e e e o e e e e e e e o o e o e e e o o = — = —




Eykatdotaon

Ze 11 avTioToixouv o1 KAépeg Tou S7-200 (CPU 222)

6 £€0dol pikpopeal Q0.0 Ewg Q0.5  Tpopodoaia:
(24VDC/24-230VAC max. 2A) (85 - 264 V AC)

OO0 000

Q0000000900 O | Khreupooelpd eE63wv

1L 0.0 01 0.2 ® ® N 1L

i 0.0 01 0.2 0.3 2M 0.4 0.5 M L+
000D DO®O® | Khiuuooepd e106dwv

o 011 |||||

[ Evowpatwpévo TpopodoTikd
24V DC/ 180 mA

i
|
1

6 e{codot 10.0 wg 10.5 (24 V DC) yla TG el06d0UG Kal TIG HovAdEG EMEKTAONG .

Kwdikdg S7-200 - CPU 222 eEddoug uikpopehal
6ES7 212-1BB23-0XB0






Eykardoraon AoyiopiKoU 2

2.1

Eykardoraon Tou AoyiopikoU ripoypappaTtiopou STEP 7-Micro/WIN

Ma va eykataoTtrioete T0 AOYIOUKO TIPOYPARUATIONOU Tou S7-200 (STEP 7-Micro/WIN)
xpelaleate évav H/Y 1 éva npoypaupatiotd g Siemens (PG) pe Windows 2000 SP3 1
petayevéotepo, Windows XP Home, 1) Windows XP Professional.

1. TonoBetiote To CD otov H/Y 1) oto PG pe Aeitoupyikdé ouotnua tng Microsoft
2. Em\éEte Vv eykardotaon

3. Zekwnote 10 gpyaleio eykatdotaong (Installation Wizzard) kat akoAouBeiote Tig 0dnyieq

2

Choose Setup Language

[4 1 Select the language for this installation from
f the choices below.

|Engish -
Enlish k
French (Standard)

German

Italian

Welcome to the InstallShield Wizard for STEP Spanish
7-Micro/WIN V4.0.4.16

Inueiwon: Av eixate eykareotnuévn pia mponyoupevn €kd00T Tou AOYLOKOU
STEP7-Micro/WIN installed 8a oag {ntnBel va aneykataoTHoeTe TO «TIAAO» AOYIOUIKO
Kat va enavekkivijoete Tov H/Y. Apou €xel aneykataoTtabel To aAld AoyLOUIKO, avoiETe
kal kKAelote Tov 0dnyod tou CD yia va Eekwvrioel kat idAL 1 dladikaoia eykatdotaong.

210 T€AOG TNG eykatdotaong eppaviCetal n erhoyr “STEP 7 Micro/WIN” oto pevou
ekkivnong tTwv Windows, Start>SIMATIC

11



Eykatdotaon Aoyiouikou

2.2 =eKivnua pe To STEP 7-Micro/WIN

>1o Simatic, ou BpiokeTal oo pevou Start, 6a Bpeite To STEP 7-Micro/WIN V4.0.
Ekel Bpiokovtal Ta ewovidia tou STEP 7-Micro/WIN.

ZEKIVIOTE TO MPOYPAUUA KAVOVTAG KAIK |IE TO TIOVTIKL.

[T S7-200 Explarer 1,046 4 |

Bl STEP 74w va0 216 » [T

¢ [ TD Keypad DesignerVi.04.16 » 5 Readme
JIE STEP FMiciow!

[l Fragrams

< Documents L
D = Sellings 3
4 Search 2

W) Helpand Suppart

P

J Lag OFf haoera..

0] ShutDown..

| Shan - -

5| Windows XP Professional
G




Eykatdotaon Aoylouikou

2.3

To pevou Bonéciag (Help)

To STEP 7-Micro/WIN €xel €va oAU L.oxupd pevou Tou ipooPEpPeL on-line Boribela, onwg kat
ol AN\eg epapuoyEg Twv Windows .

Eru\éyovtag to pevou Help Bpiokete yevikég Anpo@opieq oto pevou Contents kat
TANpoQopieg yla Tov Tpoypaupationd oto pevou Instruction Sets.

Emiong rmiéfovrag Tautdxpova Shift & F1 evepyoroteitat n Bonbela “What'’s this”, o cursor
yivetal epwtnUATIKG Kal KAVETE KAIK OTO onueio Tou BéAeTe Bor|bela.

Av o unoAoyloTAG oag €xel Tipdofaon oto Internet, propeite va avtArjoete MANPoOPopIeq
OXETIKA e KATAAGYOUG, CUMBOUAEG KTA ., XpnoluorowwvTtag To pevol S7-200 on the Web
oto pevou Help.

[=/STEP 7-Micro/WIN - Project]

File Edit View PLC Debug Tools ‘Windows Help
[o=alan|s=r L
I EE

/‘k

2oy ==

L

@ What's New

B CPU 221 RELO1.10

[€H Program Block.

Program Block (&) Symbol Table

(I Status Chart

’E [£H DataBlock -
s System Block ork 1 Metwork Title

Contents and Index
‘what's This? Shift+F1

57-200 on the Web

Help Topics: STEP 7 - Micro/WIN Help

Contents Index |Find |

i Help
1 Contents and Index
‘what's This? Shift+F1

1 Type the first few letters of the word you're looking for. ]
n h

2 Click the index entry you want, and then click Display.
3-0 o Flat Buttons

13






Baoikég pubpioeic

3.1

2UvdEON HE TO KAAWSBIO EMIKOIVWVIAG

To kaAwdio PC/PPI guvdgel Tov H/Y PC pe to PLC S7-200.

Ztov H/Y 1} oTov mpoypapuaTioTr oag Ba mpémnel va Xpnoulornowmoete T 6upa USB.
Tpopodotrote to PLC e tdon.

H evdeikTikr) Auxvia STOP 1} RUN avdpet .

MpoypauuatoTriq
SIEMENS 1 H/Y $7-200 CPU

y

Oupa USB

T /

Kahwdio PC/PPI

15



Baoikég pubuioelg

3.2

16

PU6pion Tou pubpou peTddoong dedopEVWV
& opiopog TG Bupag o PG /PC

1. En\éEte TO elkovidlo communications arnd To pevou.

EAéyEte TO pevol Twv pubpioewv TG emkolvwviag.

3. Kdvte KAk 0TO OXeTIKO Tedio ylia avavéwon - ) ouvdedepévn CPU mpémnel va eupavioTel

autdéuara.

4. Avn CPU dev avayvwploTel 1§ av epgaviotel éva pevou ou avagpgpel TpoBAnuata otnv
ernkovwvia, Téte Kavte dIMAS KAk oto riedio PC/PPI cable.

Metd ané to pevou Set PC/PG Interface ermuAéEte Properties.

210 onuelo PPI emAéEte T Slelbuvon otabpou 0 Kat To pubud petddoong dedouévav
9.6 kbps. Zmv en\oyr| Local Connections diaA£Ete BUpa USB. EmBeBawwote kal

kAeloTe Ta pevou.

7. Twpa n CPU avayvwpiletal. K\elote To pevol Communications.

FJ STEP 7-Micro/WIN - Project1

File Edit View PLC Debug Tools ‘Windows
NEdg|ghlsz=e L
e s 3% % |F

Projectl

X

» x
AR A

AL Tyoe

7 Updste PLC ypo i prooct

B =[] Instructions

LT (38 Favorites
=R [Ej Bit Logic
Systern Block (@) Clock

[#-(#]) Communications
(<] Compare

(25 Convert

Inettace PL/PPI cabielUSB] 7
S

(0 Counters (I

PC/PRI CatielPPl)
sy

£3 Doubl ik
E GRenen

(28] Floating-Paint Math

g G "mteger Math
= . . pt

Communications S}l Operations

p N =
!m'" [#-(3 Program Control
o () Shift/Rotate
Set PG/PC (28) Sting
plerface =
Set PG/PC Interface x|
Access Path |

Access Point of the Application:
[Micronwin PC/PP| cablef
{Standard for Micro/WIN)

PPl =

Interface Parameter Assignment Used

PC/PPI cable(PPI) Properties.
3 None>
Copy.

#2150 Ind. Ethemet - Intel[R) PRO/1
7150 Ind. Ethemet -> Microsoft TVA/
2 PC/PP cable(PP)

Interfaces

Add/Femove: Select
Cancel Help

Propetties - PC/PPI cable(PPI) ]

PPl | Local Connection |

Station Pasamelers-

Address:

Timeout

Netwark Parameters
I~ Advanced PPI

I Multple Master Network.

Transmission Rale:
Highest Station Address:

G2

El =)

=]

Defaut | Concel |

Heo |

Propexties - PC/PPI cable(PPI)

PPl Local Connection |

Connection to:

= Hoder

oK Default

Cancel

Help




Baotkég pubuioetg

3.3 MpwTtn dokiunf AsiToupyiag

1. TonoBeteiote TOV €mAOYIKS SlaKATTN Tou BpiokeTtal KATw and To KAAUMUA TNG TIAVW
T\eupdg tou PLC ot 6€on TERM.
Mdvo e to dlakdrm otn 6€on TERM prnopeite va eruA€EeTe TV Katdotaon Aettoupyiag
(RUN v} STOP) ané tov H/Y 1) mpoypapuatioT.

2. Amné Ttov H/Y BdAte To S7-200 oe katdotaon RUN kat petd nidAt oe STOP.
H mpdoivn evdelktikr) Auxvia RUN avdBel étav to PLC Bpioketal o katdotaon RUN.
H kitpwn Auxvia STOP avdpet étav to PLC Bpioketal oe katdotaon STOP.
Av urnopeite va ald&ete Tig kataoTdoelg Tou PLC and tov H/Y oag, téte n ouvdeon
peta&U H/Y kat PLC mou €xete kdvel eival owotn.
Av n katdotaon dev aMAlel eAEyETE TO KAAWDLO Kal TN PUBoN Tou pubpoU
peTddoong dedopévav kal BeBawwbeite dtL €xeTe opioel cwotd T BUpa oTo pevou
Setup >Communications.

1.

LED SF/DIAG
LED RUN
LED STOP

PC/PPI
KAAWSL0
npog 1o PC

[=|STEP 7-Micro/WIN - Project1
Fle Edt View PLC Debug Took Windows Help

T I N e = P A = r\\ [
bt [EEE] s %2 5% [Ba []> 4 g

=18l

PrRleslssss =]

RUN

@‘ Place the FLE in FUN mode?

e | Ho Mo

17






To mpwTo MIPOYpaAUHa

4.1 FpayTte TO MPWTO CAG MPOYPAHHA

Apou kdvate pe emutuxia v mpwtn dokiur Asttoupyiag
ka E€pete 6TL 1600 To PLC 600 Kal N erkovwvia pe Tov
UroAoyLoTr} Aeltoupyouv Ba apxioeTe va avapwTIEoTe:
Nat, aMd nwg Ba PTIdEw €va mpdypapua;

Twpa Ba pdbete ypriyopa nwg va
npoypapuatileTe Tiq Baoikég Aettoupyieg Tou PLC
pe T Boribela Tou mpoypdupatog-napadelyarog

mou Bpioketal oto CD.

Mpwta and éAa Ba pudbete va avoiyete
éva npdypappa arné CD 1) and to
OKANPS S(OKOo Kal va PETAPEPETE OTO
PLC pe 1o Noylopkd STEP 7-Micro/WIN.

Metd Ba eEolkelwbeiTe e ™
Aettoupyia Tou TPOYPAUUATOg
TIOU LETAQEPATE,
Sokdlovtag To.

Me Niyeg Baoikéq YVHOEIS Tavw oﬁ7

"AoYIKEQG TIPAEELS" Ba PMopEoeTe va
avalUoeTe Ta OTolxela Tou
TPOYPAUHATOG KAl VA KATAVONOETE

TIG EVTOAEG TOU.

/
2710 KepdAawo "Meploodtepa ﬂapa6&(;1;a"\
0a pdbeTe TIG BAOIKATEPEG YVWOELG TIOU
anatrouvral ya va ypdyete Ta Sikd oag
TPOYPAUMATA 1] VA TPOTIOMOOETE TO

10 Mapddetypa Mpoypdpuatog.

19



To nmpwto npdypauua

4.2 Avoi&te TO 10 Mapddeiypa MPOyPAMHATOG

CD-ROM Drive

o9
e - e |

?‘%*’6‘@

1. TonoBeteiote To CD TWV aokroewv otov 0dnyd CD oTov utoAoyloT)
(] oTOV MPOYPAUMATIOTH 0ag).

R

[as «EP 7-Micro/WIN - Project1
Fle Edit ¥iew PLC Debug Tools ‘Windows Help

New Chrl+M

! ol CHENE

Open... Chrl+0

Close % | am J

Save Chrl+5 -

Save As... Open 21xl
Set Password. ., Lock in: (@3 Programming Exer D) & E-

Irmport. .. 1h_pr_de.mwp

Export...

Upload... Chrl+U th_pr_es.mip

Download... Chrl+D th_pr_fr.mwp

th_pr_it.mwp

Files of type: IPmiectFiIes [*.mwp] 'I Cancel y
é

Create Library...
AddjRemave Libraries...
Libraty Memorsy. ..

2. TNa va avoi&ete To TMpwTo apddetyua npoypduuarog, erAéEte File > Open.
Méoa amnd to pevou Open avalnteiote péoa and 1o CD éva napddelypa otn YAwooa
nou oagq egurnpetel. MN.x. yla ayyAikd 1hr_pr_en.mwp.

To STEP 7-Micro/WIN €xel Twpa popTWoEL TO
10 Mapddetypa MEoypduuaTog otn Kvrun Tou
H/Y 1) mpoypauuaTioT: Kat oTnv 006vn BAENETE
TA MPWTA KOUUATIA TOU TIPOYPAUUATOG.

20



To rmpwto rmpdypauua

4.3

MeTagépere 10 10 Mapadeiypa nmpoypduuarog oro PLC

[=/STEP 7-Micro WIN - 1h_pr_en
File Edit Wiew PLC Debug Took ‘Window: ''-'- 1

[hza|en|sae e [
%o %o |[C50]a8 | # % % % | ¥

System Block
% Cross Reference

]

rmm = e el e s

.

B

Symbol ar Type I Data Type \
TEMP

H petagopd mpoypduuatoq
oto PLC eivat duvarr] pévo
étav 1o PLC Bpioketat
oe STOP!

S

Communications
(X Wizards
Program Block O Took
[=)-(3] Instructions
-(] Favorites
= 3]
Symbol Table

N

Download

PPI Connection
Use the Options button to select blocks to download.

Remote Address: 2 CPU 224XP REL 02.00 - -
I = Switch 100

\l‘) Click Download to begin. m|

Data Block

Options:

IV Program Block To:PLC
v Data Block To:PLC
¥ System Block. To:PLC
[

Eneupdoelg oy katdotaon RUN eivat duvatéqg yia tig CPU 224, CPU 224XP kat CPU 226.

Kdvte KAIK e TO TovTikL OTO €lkovidlo autd yia va eeépete 1o PLC oe STOP

| (av o dakdrng Bpioketal otn 6€on TERM 1} RUN). H evdelktiki Auxvia
—_— kardotaong STOP avdpel. Mpoooxn: Me tnv evépyela autr| av to PLC
ENeyxe KArola unxavr], dev Tnv eAEyxel Tia.

Kdvte KAIK e TO TtovTikL OTO €lKovidlo autd
i Y10 VO PETAPEPETE TO AVOLXTS TEAYPAUUA
—— Tou aivetal otnv 086vn, oto PLC.

STOP). H evdeiktikr) Auxvia RUN avdpel.

Kdvte KAIK e To TovTiklL 0To €lkovidlo autd yia va Bdalete 1o PLC oe katdotaon
RUN (étav o diakdrmng Bpioketal otn 6€on TERM kat To PLC rjtav oe katdotaon

Npoooxn: Mia cuvdedepévn e 1o PLC pnxavr| propel va A T aguowvos
apxloel auéowg va kiveltar avéhoya pe To pdypappa.

KATAOTPOPN|G UAIKQV.

Mrmopeite eniong va petapépete €va npdypapua and to PLC
otov H/Y 1] Tov MpoypaupatioTr) oag.

S Kdvte KAIK UE TO TIOVTIKL OTO €1KOVIDI0 auTd yia va PeTaPEPETE éva TIPOYPaApa
o | and 1o PLC otov H/Y 1 Tov npoypappatiot oag. To mpdypaupa autod
avtikaBlotd ekeivo Tou gaivetal oTnv 08dvn. Oa MPEneL TIAVTA vVa EXETE
éva avtiypapo tou mpoypdppuartog nou Bpioketal oto PLC kal 1o okAnpd
oag dioko 1) og CD.
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4.4

22

AokIpég Kal AsiToupyia Tou 10U Tapadeiyparog

>10 10 Napddeiypa Mpoypdpparog, 24V DC ang To eVOWUATWLEVO
0 JlakdTmg SO xpnoomoleiTal yia va | | TPOPOBOTIKG Tou S7-200
Eekivdel éva KivnTrpa. N St
O dwakadrng S1 xpnoworoteital yla va
eNEYXEL TNV KATEUBUVOT) TIEPLOTPOPNG TOU meTTTeT T T

A 1
et , : $7-200 PLC 1
O1 dlakortreg SO kat S1 oTo mapadeiypa |
Bplokovtal otov simulator kat étav kKAeivouv 19 @ . __
ninyaivouv 24 V DC otig elc6doug 10.0 kat 10.1. Q0.0= Q0.1= AMayn
To HOVTENO TOU KIVITHPA CUVSEETAL OTIG K“’”g;‘/’gg KaredBuvong
€Eddoug Q0.0 (kivnmpag on/off) kat Q0.1

(Cl)\)\Cer'] KCITSOQUVOF]Q) Tou PLC. 0V DC and To eVOWHATWHEVO TPOPOSOTIKO
H katdotaon tng ewoédou (on/off) 10.0

petapépetal e To Mpdypappa otnv €£0d0

Q0.0 evy g 10.1 onv QO.1.

Eluaote €towuol va 50Klud0’(m
™ Aertoupyia Tou TPOoYPAUIATOG.

‘Exoupe ouvdéoel Tnv tdon,
€XOUE OUVAPHOAOYNOEL TA UNIKG,
€XOUNE HETAPEPEL TO TIPOYPAUMA

ané 1o CD otov H/Y kau ané
ekel oto PLC kat €xouple BAAel To

PLC oe katdotaon RUN.

AP —

OSSR
WYYV v

Awokoreg S0,51,S2, ... EEopoiwtq

K\eivoupe Ttoug dlakdrreg S1 kat
S2 kat mapatnpoupe Ta

arnoteAéopara. /

Evépyeleq ArnoteAéouara
O S0 kAeivel H Auxvia 10.0 H Auxvia Q0.0 O Kwnmpag nept-
avdpel avdpel otpépetal
OL SO & S1 kAelvouv | Ot Auxvieg 10.0 & 10.1 | Ot Auxvieg Q0.0 & O kwnmpag mept-
avdpouv Q0.1 avdBouv otpEpeTal avtiBeta

Ot Auyvieg 10.0 €wg 10.7 deixvouv Tnv
KATAOTAON TWV €L0G3WV.
Ot Auxvieg Q0.0 éwg Q0.5 detxvouv v
KATAoTAoN TwV €E6dWV.
| kat Q eival Ta oupBoAa e Ta onola
oupBoAifovtal dlebvwg ol elcodol Kat ot £Eodol
ota PLC.




To npwto npdypauua

4.5 2toixeia Ladder Logic

ZTnv Ynotakn Aoyikr untdpyouv dUo duvatég KataoTAoelg, N Katdotaon

"Peudeq" 1 "0" kat n katdoTaon "aAnegg" r "1"

HAektpoloyikd EvtoAr| kat Aettoupyia  Z0pBoAa Mpoyp/tog
ZUppoAa oto PLC oto PLC
Avixveuon:
—_— Mepvdel pelpa;
Av val, TéTe TO anoTéAeouA —I I—
—\I— elvat "aAnB€q" 11 aAwg
Aoyiko "1".
Avixveuon:
—T___ Aev mepvdel pedpa;
Av vai (dev miepvdel), Tote
To anotéAeopa eivat _I/ I_
‘l "aANBE€g" 1) MG AOYIKS

nqn

Mnvio:

Av 1O anotéAeopa "akndég"
(avtioTolxo pe To nA. pelua)
HetapepBel o éva Tmvio
1é1e TO TNViO evepyomnoleltal.

I

Enagpéq ouvdedepéveg oe
oelpd: (Aoywr) AND).
MNa va nepdoel pevpa npénet
va KAeloeL N mpwTn Kai n
deltepn enagn.

Enagéq ouvdedepéveq
napdMnAa: (Aoyikry OR).
MNa va nepdoel pevpa npénet
va kAeloel n mpwn 1
n deltepn enagn).

23
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Merarpormii evig diaypAppaTog NAEKTPIKOU KUKAWHATOG
og IPOoypappa

Mwg petatpénetal éva ddypappa NAEKTPIKOU KUKAWUATOG ot éva Tipdypaupa PLC; MoAu
arAd! MeploTpePte TO dLAYPAUMA TOU NAEKTPIKOU KUKAWHATOG Katd 90 poipeg aplotepd. O
aywyodg tpopodooiag (pdon 1 +) Ba eppaviletal aplotepd kat o oudETepog (1§ To -) deld.
>1n péon eival Ta orowxeia Tou KukKAWpatog. Me to PLC pnopouUpe va avTiKataoTrooule Ta
oTolxela Tou NAEKTPIKOU KUKAWATOG TIoU UAOTTIOlOUV Tov Autouatiopd (dnhadn To Bondntikd
KUk\wua) onwg BondnTikEG enapeg peAE, Xpovikd, Bondntikd peAé K.A.T.. Ta otolxeia Tou
NAEKTPIKOU KUKAWMATOG OTwG YA TIG €l00S0UG ETUAOYIKOL SLAKOTTTEG, UMOUTOV K.A.TL. KAl Yla
TIg €E8d0UG peAE 1oxU0G, BaABideq k.A.T. e propoupe va Ta avtikataotriooupe pe To PLC.

AMayr’]’ KQTSUGUVOHQE Zekivnua/Ztapdmpua (On/Off)
(0] 5[(1K[0Tl'l’l"|§ S1ouvdgetal KwITEa: O BLAKGTTNG SO
omv slqoBo 10.1 Tou PLC. 10.0 Q0.0 | guvdéetar oy €i00d0 10.0
To P eAs C1 QV:nKaelmaml Tou PLC. To peAé CO avtika-
ano my enaen me | ( ) Biotarat and Tnv enagr g
g&6dou Q0.1 oto PLC. £E650U Q0.0 oTo PLC.




To npwto npdypauua

4.7 Mapadeiypa mpoypdpparog 1

Ag doupe kKahUtepa tn dopr| evég npoypduparog PLC oe yAwooa Ladder (LAD).
Aut n YAwooa polddel eploodtepo and OAeg 0To SIAYPALUA TOU NAEKTPIKOU KUKAWUATOG.

AuTO eival éva axoAlo.
Xpnoworoleitat oav

/ﬂr on/off T{tA0g Y1a To SiKTUwpa
Hetwork 1 _Motor ondoff — (Network).
10.1 Q0.1 \ﬂ Me nedia oav autd
>
_| \F. J | Network 1 | | opizovrai ta
SIKTUWUATA KAt N
apibunon Toug.

Mpdypaupa 1th_pr_en.mwp oe yAwooa Ladder Motor

[~~~ P
Hetwork 2  Change of rotat. direction 100 H enogn aum
Evepyoroleltatr otav
10.1 Q0.1 | | omv eicodo 10.0

undpxel pedpa.

q\ Q0.1 To rnvio (€§0d0g 0.1
= Tou PLC) evepyorol-
_( )— eftal étav evepyorot-
\ eftain enaen) 10.1.

| Aywydg Tpopodoaiag |

Ta Atuwpata (Networks)
Xpnotuoroouvtal yia
SOUNA TWV TPOYPAMUATWY.

STL Aiota evtoAwv FBD Mok didypappa
NETWORK Hetwork 1 Mator onfoff - On= S
LD 100 — 0%
= Qoo o1 L=
NETWORK Hetwork 2 Change of rotat. direction
LD 10.1
= Qo1 Q0.1

| 04 =]

AN\eg YAWOOEG Tipoypapuatiopou eival n Alota evtoAwv (STL) kal To prok didypaupua (FBD)
ot ornoleq napouatdfovrat apandvw. Mnopoupe va aldloupe peta&u LAD, STL kat FBD oto
pevou View.
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Aeiroupyia Status (online)

Eru\éEte oTo pevolu Debug > Start Program
Status yiwa va evepyornomjoete ) Aettoupyia
Status.

Mnopeite Twpa va delte v kKatdotaon Twv
otolxelwv Tou mpoypduparog oto PLC.

EruAéETe ANl Debug > Program Status yia va
arievepyorolrjoete N Aettoupyia Status.

>1o mapddelypa, o dlakdrmg SO ouvdéetal oty
€loodo 0.0. Av o dlakdrtmg evepyoronbel Tdte
otnv 066vn, oe Aettoupyia Status, Ta evepyorior-
NUéva oTolxela Tou MPOYPAUATOG EXOUV
SLAPOPETIKO XpwHa (Ykpl) ard Ta urtdAoura.

‘Etol av €xoupe ouvdéaoel évav H/Y e to PLC
(online) pe ™ Aettoupyia Status propoupe va
doupe oV 0846vn TV KatdoTtaon Twv ototxelwv
Tou Tpoypdupatog péoa oto PLC.

Av ol aMayég oupBaivouv TIoAU ypriyopa de pro-
poUje va TIG apatnErooupe yiati xpeldletal
KATol0Gg XP4OVOog yia va eupavioTolv atnyv 08dvn.

rd

Debug Tooks Windows Help

First Scan
Multiple Scans...

Start Program Status

" v Use Ezecution Status

Start Chart Status

Single Read

Unforce All

‘Wirite-Force Outputs in STOP

Hetwork 1 Motor ondoff - On = Switch
10.0 Q0.0

| el

Hetwork 2 Change of rotat. direction -
10.0 Q0.0

— = )




To npwto npdypauua

4.9

H dopn Twv evroAwv otn Ladder

Aetrtoupyia

Baoikég EvtoAég EAEyxou

OL Baolkég evTOAEG eAEyXOU elval oL IO amAEG Oe éva TIPOYPAUA.
Kdbe evtoAr) anoteleitat and tn "Aetroupyia” kat ard Tov "teheoctn".

Teheotq

(Tu Aertoupyia Ba yivet)

To pépog autd TG eVvIoAng (3w
avolxtn enagn) -BA. oeA. 23-
SnAwvel Tn Aettoupyia rou Ba yivel.

Opdda

(A6 molo ototxeio Ba yivel n Aettoupyia;)
To pépog autd g evtoAg pag MANPopopel
Yla 7O Tolo oToLXelo Ba KAveL T CUYKEKPIUE-
vn Aettoupyia. ArntoteAeital and v €vdelgn
NG ouadag oTnv oroia avrkel To OTOLXElo
(eloodog, €£050¢ K.A.TT) Kal Tov aptBud Tou.

{ 130.0;
PN

ApBuédg

(ZTo ouykekpluévo
napddetypa To
otoixelo avrikel omv
opdda Twv elo0dwv
Kal oUpBOAieTaL e
I (Input).

O apBudg N
AMwG dlevBuvon
arnoteleftat and
Tov apBud Tou
bit kat Tou byte
TOu oTolxelou.

| ‘— AleBuvon Bit:
Telela:

AlelBuvon Byte:
Opdda

Moavég Ouddeg:

Aopn evég Teheot

Ap1Budg bit og €va byte (0 €wg 7)
Xwpicel Tig dleubuvoelg bit & byte
ApBudg pag opddag 8 bits

eloodol, €€0dol, eowTEPIKA bit pvrung,
edIKA bit pvriuNng, Kvrun LeTaBANTWY K.4.

27
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‘ANa rapadeiypara

5.1

5.1.1

1n Merarporni
Aeitoupyia AND

Zkomog: Mpénel va evepyoroleltal kat o
dlakdmng S2 pagf pe Tov SO (oto Tapddetya)
yla va AEIToUpyoEL O Kvntrpag Tou
aveulotrpa.

O dlakdng S1 énwg Kat mpLv xpnotuoroleitat
yla aA\ayry kateubuvong.

H Aertoupyia neptypdpetal wg eENg:

O kivnmpag Aettoupyel av o dlakdmmg SO Kai o
dlakadmng S2 elval kAelotol. Ze mpdypappa PLC
(oe Ladder) autd onpaivel: av ot emagég 10.0 kai
10.2 elval kAeloTég TéTE N €E0D0G Q0.0
evepyoroleitat. Ot emagég eival ouvdedepéveg
oe oelpd (Aoyikr) AND).

To npdypauua PeTATpENeTAl WG €ENG:

Aetrtoupyia AI\EE>

Ae xpeldeTal va OUPHATWOOUE TO dlakdrmm S2
otnv eloodo 10.2. H ouvdeon eival €toyun otov
€EOUOLWTT) €l00dWV. ZTNnV endpevn oelida Ba
Oelte mwg euAéyeTe, eloAyeTe 1] ofrjvete ototxela
oTo TPdypapua Kat Twg divete ovduata oToug
TENEOTEQ.

|—’~.\S1
F‘."\sz /
oC 1 w1 | (m)

HAektpikd KUKAwUa (xwpig PLC)

K1

Hetwork 1 Motor onfoff - On o= Switch 0.0 On,

10.0 10.2 Q0.0

Hetwork 2 Change of rotat. direction - Direction
10.0 Q041

— )

Mpdypaupa oe Ladder

29



AMa napadeiyuara

5.1.2
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Eicaywyn H10¢ Kavovika avoIXTHG EMAPHG OoTo TPOYpala

Av Bé\ete va elodyete a avoly enaer (m ...0.2) peta&u g ...0.0 kat Tng Q0.0, va
Onpuoupynoete dnAadr pia ouvdeon HeTA&U Twv ...0.0 kat ...0.2 e Aoyikr) AND, mipénet va
Bpeite To XwWpo drou Ba TonoBeTrioeTE TN VEQ €MaPn.

, , . Metwork 1 k atar ondoff
ToroBeTroTE e TO TIOVTIKL TO TETPAYWVO 00 550
nA\aiolo ekel drou BEAeTe va elOAYETE TO VEO . P
otolxelo. | | I L )

EruAéETe TNV Aettoupyia otn pndpa epyaciov i
EVEPYOTTIOOTE TO AVTIOTOLXO KOUMTTL.

Contact - F4

. ’ , , Matar onfoff - On=!
En\éEte Tov TUMO TG AetToupyiag oto pevou, Network 1 e :
O€ QUTH TNV TIEPITTTWON HIA KAVOVIKA avotXTh | 10.0 |
enagn. | |

_ el
Metwork 2 CHe=
10.1
| 1
1 I
Metwork 3 |
<R




AMa napadeiyuara

5.1.3

Eicaywyn oToixeiwv TeAeoTH Kai SOKIPA

Twpa npénel va kabopioete Ta oToixela Tou TEAEOTH Yla TO KawvoUpLlo OTOLXEO TOU
npoypduuarog. To npdypapua epgpavicel ta idla ndvra otoieia. Eoeiq mpénel va ta
OloPBWOETE Kal OTN CUYKEKPLUEVT TepimTwon va dwaoete: ...0.2.

Emukupwote v emioyn} oag ue to mAnkTpo Enter.

Mnv Eexdoete va owWoeTe TIG aA\ayEg Tou Kavarte!

Av Beh\rjoete va aMd&eTe Ta oTolxela Tou
Teheotr) apydtepa autd Uropel va yivel eUkoa
KAVOVTAG KAIK [IE TO TIOVTIKL OTO OUYKEKPIUEVO
onueio.

Av B€AeTE va JOKIPACETE TO VEO TIPOYPAUUA:

Mpénel va petagepete 1o nMpdypapua oto PLC
yla va 1o dokidoete. Ouunbeite OtL Tperel va
gvepyortoinBouv Kat ot duo dlakdrreg SO kat S2
Yla va AETOUPYNOEL O KIVNTNPAG.

Mrmopeite va deite mwg doulelel To KavoUplo
MPOYPAUMa Kat Je TN Borbela g Aettoupyiag
Status.

Hetwork 1 Motor ondaff - On = Switch
Q0.0

10.0

_|

Hetwork 2 Change of rotat, direction -
10.1 Q041

— )

-

5.

Debug Tools Windows Help

| First Scan
Multiple Scan:
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5.1.4
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ZBrjo1po oTOoIXEIWV TEAEOTH Kal SOKIPNA

Enmagéqg

Av elodyete a AdBog enagn] kat BEAeTe va TN ofrioeTe anAwg eAEETE TN e TO TIOVTIKL KAl
ruéote To TAkTpo DELETE.

Hetwork 1 Motor onioff - On = Switch 1000 ‘ + | Jl = | i | 1 l_| < )| ﬂ | ‘
10.0 10.2 Q0.0
; | = ) ' flline Right]'
Hetwork 2 Change of rotat. direction - Directi
10.1 Q0.1
) Hetwork 1 Motor onioff i On = Switch 10.0 ¢
1| ( 10.0 "1 oo
Hetwork 2 Change of rotat. direction - Direc
101 Q0.1 Hetwork Motor ondoff - On = Switch 10.0 On, (
_| |_( ) 10.0 Q0.0

)

Hetwork 2 Change of rotat. direction - Direction

10.1 Q0.1

— — )
Fpappég, oTiAeg Kal SIKTuWpATA File [ Edit Wiew PLC Debug Tools Windows Hel
Av BéAeTe va OBNOETE YPAUMES, OTHAEG o Undo Chrl+2 E
, , , . i =] K
1} SIKTUGUATA TETE TPETEL Va == e o Jilgl _| El@
TOMOBETAOETE UE TO TOVTIKL TO b - S sym
TETPAywvo TMAIOL0 OTa onueia autd Kat 2= Lopy Bl e |%|%| ﬂl ﬁl “'“l
ané to pevou Edit va em\éEete Delete. Easte LS b pr_en (CADocuments ¢ 4

Select &l Chledy g What's New

| CPU 216 REL 01.02
Inzert L3 .

Selection |
Find..  CikF Imn
Replace... Chl+H
GoTo.. Wertica

Chrl+G
i B Metwork[z] Shift+F3

B




AMa napadeiyuara

5.2

5.2.1

2n Mertatpori
Aeiroupyia OR

Zkorodg: Oi dakoérreg SO kat S2 mpérmel va
natnBouv yia va Eekvrioel o kivntipag. O
Kvntrpag propel entong va Eekwvroet av
niatnBel o dakdrrtng S3. Me tov S1 yivetal n
alMayn} kateuBuvong.

H Aertoupyia neptypdpetal wg eEAG:

O kivnmpag Aettoupyel av ot dlakdrreg (SO
Kal S2) i o S3 eival kAeloTol.

2e npoypauua PLC (oe Ladder) autd onuaivet:
av ot enaPég 10.0 ka 10.2 eival kAelotég A n 10.3
elval kAelot Td1e N €€0d0g Q0.0
evepyoroteital. O1 enagég 10.0-10.2 kat 10.3 eivat
ouvdedepéveg MapdMnAa (Aoyikr} OR).

To npdypauua PeTATPENETAL WG €ENG:

Ae xpeldletal va ouppatwooupe To dlakdrn S3
otnv eioodo 10.3. H guvdeon eival €Tolun otov
eEoolTH €L0BdWV.

2Tnv enduevn oehida Ba delte nwg elodyeTe wa
enagr] oe ouvdeon OR oto mpdypauua.

S1

1

HAekTpikd KUKAwUa (xwpig PLC)

Aerroupyia OE> <

Hetwork 1 Maotor ondfaff - On = Switch 10
10.0 10.2 Q0.0
’ )
10.3
»
Hetwork 2 Change of ratat. direction - Dir
101 Q01

Mpdypauua oe Ladder
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5.2.2

34

Eicaywyn enagng oe ouvdeon OR

Eru\€Ete e To TovTikL a eAelBepn Hetwork 1 Matar ondoff
B€on oto (dlo network kat elodyete pa 10,0 Q0.0
KQVOVIKA avoLXTH Emagn. I I {: ) P
|

Kdvte KAIK e To TovTiKL 0TO OUUBOAD ————

Line up om pndpa gpyaieiwv LAD.

() || ++-o|T|
~—
[ R T R .2. T R T

3o

Metwork 1 katar andaff On = Switch 10,0 Or,
10.0 10.2 Q0.0
| | | | r
| | | | L )
10.3
| |

H ernagri OR oAoKANPWONKE.

3| 2| 4+-0| 0]

Aeite oty nponyoupevn oelida nwg

Tpénel va eival To Mpdypauua oag. S
Aoxipdore To. Network 1 Motoron/off - On=Switch 10.0 On,
10.0 10.2 Q0.0
l |1 ¢
— | 1 L
10.3
_| |
I
Metwork 2 Change of ratat. direction - Direction
10.1 Q0.1
[ 1 ¢

i

)




AMa napadeiyuara

5.3.1

3n Mertartpori
Xpoviké Kabuotépnong ‘EAENG

Zkomodg: Oa mpoobEéooupe aTn AstToupyia
L XPOVIKY) KABUGTEPNOY XENOULOTIOLVTAG
€va Xpovikd KabuoTtepnong EAENG.

‘Otav evepyonoleital n eicodog 10.3 (S3) 6a
apxiCel va katauetpdtal €vag xpovog
avapoviig Kat o kivntipag Ba Eekivdel va
Aettoupyel (ue v evepyortoinon g Q0.0)
peTd v idpodo Tou Xpdvou autou.

21N ouykekpLévn mepimtwon de xpeldletal
kauia epyaocia ocuppdtwong. OAeg ot
aMaygg yivovtal oAU anAd oto
npdypaupa tou PLC.

ZTnv enodpevn oehida 6a doupe ™
AetTtoupyia Tou xpovikou

kabuotépnong €AEng oto S7-200 kat

wg Ha TV EVOWUATWOOUE OTO

TPSYPApHA HaG.

k. \ s2

o]

K2 K1
)1 C3| (w)

K1

HAektpikd kKUkAwua (xwpig PLC)

Hetwork 1 1 zecond time delay timer
ztarted by 10.3 switch contact
10.3
| |
| [ IM
+100-4PT
Hetwork 2 katar anoff Or = Switch 10.0 On,
10.0 10.2 Q0.1
| | | | !
| | | I b )
T34
| |
| |
Metwork 3 Change of rotat. direction - Direction
101 Q0.1
| | r
1 | hS )

Mpdypaupa oe Ladder
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5.3.2

36

H Asitoupyia Tou Xpovikou

Metwork 1 1 second time delay timer
started by 10.3 switch contact

TON

2 ms

4 lNa va \ -
AEITOUPYNOEL TO

XPOVIKO TIPENeL va
evepyorolnBei.
270 napddetyud

Xpeldleote €va XPOoVIKO
Tou 1s. To S7-200
(CPU 212) €xel 64 xpovIK4,
ané 1o TO éwg 1o T63.
Xpnouonowyote To
XPOVIKO T34.

pag autd Ba yivel
ue v eloodo 10.3
TIou ouvdEeTal

PuBpiote xpovo 1s ypdpovtag mv Ty 100
omv &{codo Tou xpovikou "PT". O xpdvog
urtohoyiCetat and v Tyr Tou BAaoupe otnv

omv £0050 "IN" eloodo PT (8w 100) eni ™ Bdon xpdvou Tou
TOU XPOVIKOU. XpPovikoU. (O T34 éxet Bdomn xpdvou 10 ms,
;/ 100 x 10 ms = 1s).
Bdon
Xpdvou T /
1ms T0,, T32, T64, T96

10 ms T1-T4, T33-T36, T65-68, T97-T100
100 ms | T5-T31, T37-T63, T69-T195, T101-T255

2t CPU 222, ta
XPOVIKA €xouv Bdoelg
Xpoévou 1 ms, 10 ms kat
100 ms. To B0 xpovikd
dev MpEmeL va
Xxpnotuoroleftatr Eava

Kdbe xpoviké oto S7200
€xel a enagn| (ttmer bit)
rou Jeilxvel, avéhoya pe Tov
av eivat ON 1} OFF,
av 0 XPOvog mou HeTPAEL
TO XPOVIKO €xel 1] Sev €xel TiepAoEL.
270 Jldypappa mou aKoAoubel
paivetal n Aettoupyia Tou
XPOoviKoU.

. P T34
péoa oe éva _I I_
npdypauua. k
INeg.10.3
A
5_ _______
PT=5 A B
i.e. 3t—=—=—==—--
5x10mMs of === === I— — —
in T34 ) I
Txx e.q. T34 [
Olwithbase 10ms ; ! Pl 0 |
| 1
| | |
1%3 o ! !
T3‘i_ Timer bit of T34 1 : :
i1 ] ]
- 1 1 .

Aldypappa Aertoupyiag xpovikoUu T34 pe kaBoplopévo xpdévo pérpnong: 50 ms
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5.3.3

MpoypapHaTIONOG TOU XPOVIKOU

Xpnotorowwvtag v Undpa epyaieinv
» 1

ol o] | 50les| e[| 2| % 2]

Inzert Metwork, | d '-l-()lﬂ

2 o gy Fgf o 4

MNetwork 1 1 second time delay timer
started by 0.3 switch contact

|| >

Metwork 2 Motor ondoff - On = Switch [0.0 On, O
10.0 10.2 Q0.0

] | ] |
1 I | I |
SHR_WY -
Y | [rem it
SART
SUB_DI
SUB_|
SUB_R
SWWAP
THL_FIND
TOF

Fat

TONR
TRUNC —
WAND_B

WAND_DW
WAND_

Metwork 2 Mator ondoff - On = Switch [0.0 On,
10.0 10.2 Q0.0

| | | =

. [a va xpnotyononoete To

XPOVIKG OTO MPAOYPAUMQA TIPETEL
va To elodyete o€ €va dIKTUwa
mou va Bploketal mptv and autd
érou Bpioketal n Aettoupyia OR.
Ma va elodyete véo dIKTUWHA
KAVTE KAIK O€ éva OTOolKelo Kal
TEOTE TO TMAAKTPO.

. Apou oto VEo SikTUwa elodyeTe

mv kav. avoiyt enaen 10.3
npénel and ta pevou va eTUAEEETE
TO Xpovikd (On-delay timer) kat va
TO €l0AYeTE OTO JIKTUWHA.
EruAéETe TO pnoutdv Box-F9 o)
urdpa epyaieinv.

. EruA€Ete v Aettoupyia TON (on-

delay timer).

. EruA€Ete ta nedia PT kat TON kat

€loAyEeTE TIG TIHEG, O QUTH TNV
nepimtwon 100 and T34.

. 210 Teheutaio Briua, To bit Tou

XPovikoU T34 mpénel va eppavi-
Cetal network 2 ot 6€on g
enapnq 10.3. Kdvte v diépbwon.

AoBnkeUoTe TO MPOYPAUMA KAl
OOKIUAOTE TO LUETAPEPOVTAG TO
oto PLC.
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5.4.1
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Aoulelovtag pe projects
ZUHBOAIKGG TIPOYPAUHATIONOG

Méxpl oTiyung xpnoluorotmjoape yia ta didgpopa ototxeia oto npdypauua Tou PLC Tig
ovopaoieg Twv TeAeotwy Onwg 10.0, Q0.0, T34 k.A.. Av Spwg To MPdypapua pag sivat mo
peydlo, autou Tou eidoug ol ovouaoieq dev eEunmpetouyv. Oa rjtav TIoAU XPrOWo av
priopoucape va ovoudooupe énwg BéNoupe ta otolxela Tou poypdupaTog. Autd akpIBWg
yivetal pe To oUPBOAIKS TIpoypapMaTIoONd (1) cupBoAkr dleubuvoloddTnaon).

Fle Edt View F 1. Ma va mpayHaronowcoupe T oUMBOAKY dleuBuvolodd-
Dlzle| & TNOoN TPEMEL VA CUUMANPWOOULE TOV TIiVAKA TUUBOAWV.

En\éyoupe Tov Tiivaka oUUBOAWV XPNOLOTIOLVTAG TA
MAriktpa Symbol table oto pevou View.

Micro/WIN - 1Th_pr_en
iew PLC Debug Tools “windows Help

= e e B MR (R} TEP 7-Micro/wWIN - 1h_pr_en
|
«E I% ‘lm‘lt’)‘lnl ﬁ ?-Y-I LT Wiew PLC Debug Tools Windows Help

7 ‘
| STL ]
Symbol Table — = = | [al=x] gl)e
el | [cd Program Elock ‘I v Ladder y—l 21k

Program Block

E <7 POU Symbals
Program Block () Status Chart
(g3 Data Block

v Symbolic Addressing Chrl+

Stat t
Symbol Table » BRI

5] System Block . Data Black
E C‘:’IDSS Reference v Symbol Information Table Chl+T Sl
POU Comments Cross Reference
MNetwork Comments Communications
Set PG/PC Interface
Toolbars 3
REms N Network 1 M
10.0
Bookmarks »
RN IR IR BN TN - TN RN X
)| Symbol Address Comment

1 S0 10.0 Switch 0

2 51 104 Swich 1

3 52 10.2 Switch 2

4 53 10.3 Switch 3

3 Mator_OM Q0.0 Turhs motor ON

B Direction Q0.1 Changes the direction of the matar

7 Delay_1s T34 Waits 100 = 10ms = 1 second

8

9

2. 210 napdbupo Tou Tivaka CUMBOAWY TIoU eUPAVIZETAL CUUTTANPWVOUE 0T OTHAN
Address Ta otolxela Twv TeAeoTwy, ot otrAn Symbol Name Tn cupBoAkn)
ovopaoia rou BéNoupe kat otn otAn Comment orolodrnoTte oxOAo TTou
vopiCoupe 6Tt Ba pag Bondrioet. AnoBnkeUoupe TN SOUAELA TTOU €XOUE KAVEL.

Zuvéxela omy endpevn oeNida
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Xprion Twv cupBoAwv oTo TIPdypappa

@STEF‘ 7-Micro/WIN - 1Th_pr_en_fix

File  Edit | Wiew PLC Debug Tools ‘Windows:

=

» H
AR AR

STL
v Ladder
FBD

Status |

Symbol T able

v Symbol |nformation Table Chrl+T

FOU Comments
Metwork Comments

3. Ano To pevou View > Symbolic
Addressing kdvoupe tnv emoyn
va BAEMOUE TO MPAYPAUMA LE TIQ
OUMBOANKEG OVOUAOiEG.

4. Av éxoupe eMNEEEL TOV OUMBOANKO

Toolbars ' TPOYPAUUATIONO, aMdEoupe og LAD,
Frame D STL 1j FBD, ol GUUBOAIKEG OVOUAGIEG
Bookmarks » npénel va eppavidovral.
Froperties...
Metwork 1 1 second time delay timer
i started by 10.3 switch contact
S3:10.3 Delay 15734
IM TOM
! |
+1004PT 10 ms
Symbaol Address Cormment
Delay 1z T34 Waitz 100 % 10mz = 1 second
53 10.3 K]
Metwork 2 Motor ondoff - On = Switch [0.0 On, Off = Switch 10.0 Off
S0:10.0 S2:10.2 Motor_ON:Q0.0
| | | | r )
I | I \
Delay 1=T34
|

5. Z1o mapandvw oxrjua gaivetat To npdypapua oe Ladder e oUUBONKEG
ovouaoieg. Mropeite BERala kat va MPoypaUpATIOETe e Tov TPOTo autd
Xpnouuorolwvtag yia napddetypa S3 avti 10.3 apkel va éxete dSnAwoel TV
avtiotolxia otov mivaka cUpBOAwV.
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5.4.2 Anpioupyia véou nipoypdapparog (Project)

Av Twpa BéAeTe va ypdyeTe €va kawvouplo Sikd oag pdypappa Ba npénet apxikd va
dnuoupyrioete €va véo project. To project autd Ba eival pia opdda and apxeia mou
oxetiCovral e To MPOYPAUa 0ag Onwg TOo (B10 To TPAOYPAUMA, TO APXE(O HE TIG CUUBOAIKEG
ovouaoieg KA.

1. Anpioupyriote €va véo project and To

| File Edit View PLC Debug Tor pevou File > New.
Chrl+N
Open... Clrl+0
Close .

Save N
Save Az \\q /

Set Password...

2. To anotéAeopa eival €va project pe to
Impart... Sévopa Project1. Mmnopeite va Eekwvroete
Expart... TOV TIPOYPAUMATIONO.

@STEP 7-MicroWIN - Project]
File Edit “iew PLC Debug Tools ‘windows Help

Dleslel slnl slwe| of 2w =] o] Bl =] 5mE)E

Meploodrepeq olthe] []l8] o6 )% Flom| 2| 5] 4oo| D]
'I'[)\T]DO(PODlSQ Wiew =] Project] 3 3
. = T2 g
omv S'I',[OHSVT'] @ What's New
oelida B CPU 224%F REL 02.00 BV TE\::F', Tvpe
=] @ Program Block TEMP
Pro Blo @ Symbol Table TEMP
@ Status Chart TEMP
=== [£H Data Block
System Block
- % Fross Hetfele..nce Network 1 Metwork Title
Communications

(%) wizards
= C‘qf Toals H
= -] Instructions
(3] Favorites
(51 Bit Logic
(@) Clock Network 2
(#] Communications
(<] Compare ;l
[ag] Convert

(3] Counters

[ - - B
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i,‘_| STEP 7-Micro™IN - Project]

File Edit %iew PLC Debug Toc

e Ctrl+M
Open... Ctrl+0
Cloze

Save Chrl+5

Set F'asswun;\ =
Impart... \_/
Expaort...

3. Ano6nkeuote To Project1 pe To
évopua Tou BENETE XPNOLUO-
TIOLWVTAG TN OXETIKY EMAOYY OTO
pevou File > Save as...

4. Awote To dvopa Tou BEAETE
kabwg kat oe Told onpeio Tou
dlokou BéNeTe va anoBnkeuBel
T0 project. Anobnkeuote to OK.

21|
Savein: I ) Projects j“ ok B3~
N
PR
=
)
File name: |F'roiect1 mwp Save I
Save as type: IPvniact File [*.mwp] & P J
_— 2
\ \

Metd ané autd ta Brpata, £Xete dNIOUPYTOEL
éva véo project e éva véo apxelo
npoypduuatog. Mropeite Twpa va ouvexioete

va SOUAEUETE € TO YVWOTO TPATIO.

41



AMa niapadeiyuara

/ Zuyxapntnpela, \

Twpa EEpeTe va mpoypapuaticete
10 PLC S7200.
Av BENeTE va UABeTE
eploodTePa
Ba Bpeite xprioleg MANPoOPopPIieg

oto Mapdptmpa. /

42
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5.5

O€AeTe va pabete IEPICOOTEPQ;

Oa Bpeite napadeiypara epappoywv oto pakeMo “Samples” oto STEP 7-Micro/WIN kabwg
kat oto CD.

Tig o MoANEQ TANpoPopieg Ba Tig Bpeite BERala oto eyxelpidlo Aettoupyiag Tou S7-200.

Ma eknaideuon oxeTikd pe o S7200 (ogvdpLa, apouctdoelg K.A.) WAAOTE e ToV uteUBuvo
g Siemens.

Epwtioelg;
Arnopleg;
Texvikd MpopAAuatq;
H Siemens 6a xapel va cag Bonbroet.

Ektdg and tov unelBuvo Tng Siemens OTn Xwpa oag
Hropeite va ameubuvBelte kal 0To KEVIPIKS TUNA
Yrnootipt&ng Mehatwv Tng Siemens ot Mepuavia
oto TMAEpwvo +49 180 5050 222.
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MapapTnua A

AA

Bits, Bytes ka1 Words

H ukpdtepn povdda nmAnpogopiag os éva Ynelakd cuotnua eivat yvwotr cav “bit”. ‘Eva bit
propel va €xet dUo pévo TIHEG: “0” (Un aAnB€g) Xy “1” (aAnBEg).

‘Evag d1akdITINg yia 1o pwg €xel Kat autdg dUo Povo duvateég Kataotdoelg: “To pwg sival
avauuévo” 1§ “to pwg dev eival avappévo”. H katdotaon Tou dlakértn sival andvinon otnv
epwtnon “Eival To ¢wg avaupévo;” Kat n andvrnon autr propel va sival eite “aknbég” elte
“Un aAnBEg”. Emopévwg o dlakdmmg dlabetel peyebog nmAnpopopiag oo kat €va bit.

>e éva PLC, ta bit eival xwplopéva oe opddeg. Mia opdda ard 8 bits ovopdletat byte. Kabe
bit kaBopiletal and ™ B€on Tou Tou ovouddletal kat dleubuvor). ‘Eva byte €xel pia diedbuvon
byte kal dleuBbuvoelg yia Ta bit and 0 €wg 7. Mia oudda and 2 bytes ovouddetat word.

2T1a Ynolakd cuomuata ot aptbuol eivat duadikoi, £xouv dnAadry oa Bdon to 2.

20 Av 1 Tr) Tou bit autou eivat “0” (= pn aAnB€q ...) Téte To bit €xet a&ia 0
) yat{ 0 * 2° = 0 (tury * 6€om Tou bit).
1 bit = I:l Av n Tiry Tou bit Atav “1” (= aAnB€g) téte n agla Ba rytav 1 yuati 1*2° = 1

~~

Autr elvat n B€om Ttou bit 2° oe éva byte!

Kdbe bit oe éva byte pnopel va €xet v Tyn
27926 25 24 23 292 91 90  “1” A “0”. Ta bit umopouv va xpnatuornomn8ouv
EeXxwpPLoTA (X, oav enagEg) 1y oav opdda
1 byte = | | | | | | | | | (.. o€ byte) avanaplotevtag évav aptoud
and 0 €wg 255.
(27 +26425424423422421420 = 255,
20=1, 21=2, 22=4, 23=8,
2¢=16, 2°=32, 26=64, 2"=128).

Aum eival n 6€on evég byte péoa oe a word!

N

215 214213212211210 29 28'27 26 25 24 23 22 21 20I

tword= [ | [ [T LT TP T TT|

Mia word oe éva PLC avarnaptotd évav apiBuéd and -32768 €¢wg +32767. Me To bit 25 dnA\wvou-
He av 0 aploudg eival apvntikdg 1y BeTIkOG (av N Tyr| Tou eival “1” o apBudg eival apvnTikdg).
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46

Mepilox€qg dieubuvoewv Tou S7-200

OL ieplox€q dleubuvoewv oe €va PLC eival ol TEPLOXEG TNG MVIING TOU TIOU QVTLOTOLXOUV OTIG
KATAOTACELG TWV €l00dWV Kal Twv e§6dwV Tou. MN.X. av g pia elcodo Tou PLC undpxel tdon
TéTE OTN WVrUn Tou, otnv avtiototxn dleubuvon Ba urdpxet n T “1”. H mieploxn Kvriung
evoqg PLC mou avtioTtolxel oTiq kataoTtdoelg Twv el00dwv ovoudletal “process image of the

inputs” (PIl) kat n TepLoXr) MVAUNG TIOU AVTIOTOLXEl 0TI KataoTdoelg Twv e£6dwv ovoudletal
“process image of the outputs” (PIO).

Meploxég Aleubuvoewv oe éva S7-200 PLC pe CPU 222

AiedBuvon Byte
/76 5 4 3 21 O(-/Alsueuvoan

E{oodou:
0. €—— Eioodo1 evowpatwpgveg otn CPU (10.0 to 10.7)
1.
— Meploxn dleublvoewv yia TG HoVADSEG EMEKTAONG
2. (n CPU 221 3gv déxeTal HOVASEG EMEKTACNG)
13.
14. \
5 Meploxn} eAelBepwv dleublivoewy
’ ot CPU 221 (10.6 wg 17.7)
115.
Alel Bi
765 43 21 0 — leuBbuvon Bit
‘E€odoLl: QO.
‘E€odol evowpatwpéveg ot CPU (Q0.0 to Q0.5)
Q1. [
a2 F — Meploxr} dleubUvoewv yia TIG LOVASES EMEKTAONG
Q3. ot CPU 221 (Q1.0 to Q4.7)
Q4. \
Meploxn} eAelBepwv dleublivoewy
Q5. om CPU 222 (Q5.0 to Q7.7)
Q15.
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A3

KukAIKr) ekTéAeon mipoypApparog oto S7-200

‘OAa ta PLC SIMATIC Aettoupyouv KUkAIkA. Katd tn didpkela Tou KABe KUKAOU oL
KATAoTACELG TwV €l00dwV “dlaBdlovtal’ OTIG QUOIKEG ELGODOUG KAl UETAPEQOVTAL OTIN UVIAUN
otnv mieploxr| Process image input. 2tn ouvéxela ekteleital To pdypappa pe Baon Tig
KATAOTACELG QUTEG Kal TN AOYIKN TwV evToAwv. Ot kataotdoelg Twv €E6dwV TpormomnolouvTal
avtiotolxa otnv Teploxn Kvrung Process image output kat 0to TEA0G ToU KUKAOU
peTapgpovtal OTI§ PUOIKEG €EGS0UG. MeTd, 0 KUKAOG emavalauBdavetat.

x} ‘Evap&n kUk\ou

¥ I ,
; |K |\ Elcodol

N/

o1 |2 sEssEssEEsEEmEEEn n

Y

Mivakag

v

Hetwork 1 Motor onfoff

Mpdypauua STEP 7: 10.0 Q0.0

- Bit pvrung — — )
- Xpovika
- AnapBunTég

Hetwork 2 Change of rotat)
10.1 Q0.1

— )

A 4

Mivakag

Y

sssssssssEEEEEEns n

R

AV

TENOG KUKAOU

>
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